AutoCAD 2017 for Mac Preview Guide
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User Interface
Significant changes have been made to the user interface for AutoCAD 2017 for Mac.

= The tool sets have been redesigned for better organization and to provide access to more tools.

= Atoolbar has been added above the drawing window containing frequently used commands
such as New Drawing, Save, Open, Undo, Redo, and Print.

= File tabs provide an easy way for you to access all the open drawings in the application.

= Layout and model tabs are now available in the lower-left corner under the drawing area, to
easily switch between the Model and the existing layouts.

=  The Status Bar has been updated and is now in line with the Model and Layout tabs.

= The layer tools have been added to the Properties window for easy access and the Properties
window is part of the application frame.

= The Layers palette contains more layer properties.

= The command line is anchored at the bottom of the drawing area.
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Tool Sets
The tool sets are divided into two tabs: Drafting and Modeling.
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Note: AutoCAD LT does not contain the Modeling tab.



Each tab contains predefined standard panels, grouping related commands together. Click #& on any
standard panel to select which commands to show or hide from that set.
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You can change the order of the panels on a tool set.

¥ Parametric
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Drag the panel titles to define the order.
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Collapse a panel when not using the controls. The title for the panel is still visible so you can expand the
panel when needed.

¥ datch » Hatch

Toggle Tool Set width




The mini tool sets use small icons for all commands.
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Custom Tool Set Panels
You can create custom tool panels. Click the plus sign (+) at the bottom of the tool set.




Enter a panel title, select the icon layout, and add commands and dropdowns.

Select layout

Edit title

Real time view =

]

While creating your custom tool set:

Remove command
or drop-down

e Drag commands from the full command list to the preview panel.

e Hover over a command to see the command name and description.

e Use Shift or Command to select multiple commands to add to the tool set.

Drag from complete
command list

Click outside
interface to exit

Command
search

e Easily add a dropdown and drag commands under the dropdown to create a subset of icons.

= All changes happen in real time so you can immediately see the changes made.

= To edit your custom panel later, click £ on the panel to return to this view.

= To delete a custom panel, move the mouse over the panel to see the i putton. Click i to

delete the custom panel.
= Standard tool sets can’t be deleted.



Toolbar
A toolbar has been added above the drawing window. This toolbar contains frequently used commands
such as New Drawing, Save, Open, Undo, Redo, and Print.
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File Tabs

File tabs provide an easy way for you to access all the open drawings in the application.

@ AutoCAD2017 File Edit View Insert Format Tools Draw Dimension Modify Window Help
C Drawing3.dwg
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Drawing3*

= (Clicking the plus sign (+) on the file tabs bar opens a new drawing. If a default template isn’t
specified in Preferences, you can select a template. That template is used as the default from
that point on.

= Use Control+TAB to navigate through the file tabs.

=  Right-click on the file tabs to access the shortcut menus that have options to open, close, or
save drawings.

= Click B:I to open the Quick View where you can preview and switch between open drawings
and layouts in an open drawing.
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Quick View Panel
You can now select and delete multiple layouts on the Quick View panel.
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Layout Tabs
Use the layout tabs, located in the lower-left corner under the drawing area, to easily switch between
the model and the existing layouts.

e VA NN

e Click to create a layout.
e Drag any layout tab to change the order listed.

e Right-click a layout tab to rename, delete, or copy.
e Press command+] to switch to the next tab or command +[ to switch to the previous tab.

11



Status Bar
The Status Bar has been updated and is now in line with the Model and Layout tabs. Command+6
toggles the display of the Status Bar along with the Model and Layout tabs.
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Properties Window
The Properties window is now part of the application frame. It can be turned off or on and you can
change the width. Layer controls are added to the top of the Properties window for easy access.
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Layers Palette
If you need to see more layer properties than what are included on the Properties window, you can
open the Layers palette by any of these methods:

e C(Click the button in the upper right of the Properties window.
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Unsaved Layer State

Properties

Color m Bylayer

e Press Command+4
e Select Window menu > Layers.

More properties are now included on the Layers palette.
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Importing PDF Files

PDF files are a common way of publishing and sharing design data for review and markup. AutoCAD
currently supports creating PDF files as a publishing output for AutoCAD drawings. PDF files can be
attached to drawings, which can be used as a reference when collaborating on projects. In AutoCAD
2017 for Mac, you can import the geometry, TrueType text, and raster images from a specified page in a
PDF file, or from all or part of an attached PDF underlay.
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IMPORT Command
The Import tool, available from the Toolbar and File Menu, enables you to import geometry from a PDF
page into the current drawing as AutoCAD objects.

m Edit View Insert Format Tools Draw Dimension Modify Parametric Window Help
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Import...
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Save #S
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Plot Styles...

Print... #P
Batch Publish...

In the Import File dialog, you see that PDF has been added to the list of supported file formats.

) §< EH] E o B!y PDF_Import s Q
Favorites Name ~  Date Modified E
Recents = Architectural - Anno...tileaders - Copy.pdf Dec 21, 2015, 5:56 PM 783
. . & Architectural - Anno...nd Multileaders.pdf Dec 21, 2015, 5:56 PM 783
& iCloud Drive a cecilia.pdf Jun 11, 2015, 9:59 AM 325
7 Applications : A
] Desktop 194.p09 22
% Chart.pdf Jan 14, 2016, 10:41 PM 22
[ Documents = Floor Plan Sample-Model.pdf Dec 15, 2015, 1:48 PM 143
o Downloads = Hatch-Model.pdf Dec 21, 2015, 6:37 PM 31
Devices = ImportSettings.pdf Feb 16, 2016, 3:00 PM 6
(©) Remote Disc o gl v
E backup 3 J 3
EJ 1041 a lighweight.pdf Jan 8, 2016, 5:36 PM 2
3 & MakeDWG,pdf Jan 8, 2016, 5:29 PM 226
[ Autodesk A... = -
ACIS (*.sat)
(A0 % v PDF Files (*.pdf) 7
All Files (**)
Options Cancel
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After a PDF file type is selected, the Import PDF dialog is displayed and allows you to:

e Choose which page from the selected PDF file to import

e Specify the Scale, Rotation, and Insertion point of the imported geometry

e Control what type of data is imported from the PDF (Geometry, Solid fills, Text, and Raster
objects)

e Control how layers are assigned to imported objects

e Set different postprocessing options for imported geometry

Import PDF

File name: Architectural - Annot...g and Multileaders.pdf Page to Import

Browse Page: 1 Total: 4 (o]
Location
Specify insertion point on-screen
Scale: 1.0000 Rotation: 0 [ v
PDF data to import Layers P s |
. = g K i
Vector geometry © Use PDF layers =+ =X
Solid fills Create object layers 2
TrueType text Current layer
Raster images . E
Import options A > & ‘;'
Import as block
Join line and arc segments
Convert solid fills to hatches 3 4
Apply line weight properties Page size: ANSI A (11.0 x 8.5 inches)
Infer linetypes from collinear dashes PDF scale: 1:1
%% Cancel Ok

Raster images are extracted as PNG files and attached to the drawing.

The “Convert solid fills to hatches” check box joins 2D solids with coincident edges and converts them
into hatch objects. Note that this option increases the processing time.

The “Apply lineweight properties” check box applies the lineweights in the PDF to the extracted
geometry. When cleared, all imported geometry is assigned AutoCAD’s default lineweight.

The “Infer linetypes from collinear dashes” check box looks at collections of collinear dash and dot
segments and replaces them with a single polyline. A dashed PDF_IMPORT linetype is created and
applied to the polyline and assigned a linetype scale based on the length of the dashes. This setting
reduces the number of objects and makes it easier to edit the geometry, but some fidelity is lost. If
cleared, each segment in a dashed line is imported as a separate pline.

In the Application tab of the Preferences dialog, you can specify the file location for image files that are
extracted from the PDF and attached to the drawing. The default path is in the PDF Images folder which
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is relative to the location of PDF file being imported. The path can be either absolute or relative.

=] L] Application Preterunces

Files
» [0 Support File Search Path
» £ Working Support File Search Path
» @ Project Files Search Path
» D) customization Files
» [[) Text Editor, Dictionary, and Font File Names
» [[) Printer Support File Path
» [ Automatic Save File Location
» [ Color Book Locations
» [ Template Settings
* [ Log File Location
» £ Texture Maps Search Path
» I Web File Search Path

v 2 PDF Import Imi Location

+| =@ Reset hicden messages Reset Application Options...

eto o (KN

The PDF file format doesn’t recognize SHX text. When drawings with SHX fonts are plotted to PDF, the
PDF stores that data as geometry (not text), so the SHX text is imported as geometry. Text with
TrueType fonts are imported as text objects.

PDFIMPORT/-PDFIMPORT Command

The new PDFIMPORT command (—PDFIMPORT if using command line access) offers an alternate way for
you to import PDF geometry into the current drawing. The initial options provide a choice either to
select an attached PDF underlay, or to specify a PDF file.

PDFIMPORT Select PDF underlay or [File] <File>

If you choose the File option, the Import PDF dialog is displayed just as when you use the IMPORT

command.

If you select an attached PDF underlay, you can specify a rectangular or polygonal boundary around the
objects you want to import, or you can import everything.

PDFIMPORT Specify first corner of area to import or [ Polygonal/All/Settings] <All>

You can also choose to keep, detach, or unload the PDF underlay after the objects are imported.

PDFIMPORT Keep, Detach or Unload PDF underlay? [Keep/Detach/Unload] <Unload>
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The Settings option in the PDFIMPORT command displays a dialog that provides the same settings as
those in the Import PDF dialog.

(] PDF import settings
PDF data to import Layers
Vector geometry © Use PDF Layers
Solid fills i .
Create object Layers
TrueType text

| Raster images Current layer

Import options

Import as block
Join line and arc segments
Convert solid fills to hatches
Apply line weight properties
~ | Infer linetypes from collinear dashes

? Cancel Ok

If you select a PDF underlay that is attached to the current drawing, you can access the Import PDF tool
from the visor of PDF Underlay.

oor TR

PDF Underlay
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Publish to PDF

Buttons are now available to add the current drawing and remove the model space sheet from the list

for publishing. The dialog is also now resizable.

Publishing is updated with PDF.pc3 support. You can now pick one of the five predefined PDF presets

when plotting your drawings to PDF. These presets provide a way to quickly set different PDF output

options that fit various purposes.

‘o0 @ Batch Publish

Publish to: | PDF d Sheet Name

L3

Preview not available

Status

Source drawing
Drawing location
Layout name
Plot device

Plot size

Plot scale

Page setup detail

Publish Output
Preset: AutoCAD PDF (General Documentation) E @
Location: /Users/murnenp/Documents/ v
Single PDF with multiple sheets
Include plot stamp BTN

Open when complete

Page Setup Status

+|— €. Add current drawing L Add open drawings

Publish Options Information
Layer information: Include
Font: Embed all referenced fonts
Vector Quality: 1200 dpi
Raster Image Quality: 400 dpi

Merge control: Lines overwrite

Cancel
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1=2

Click PDF Options to modify the individual settings.

@ PDF Options
Quality
Vector quality 21200 E,l dpi
Raster image quality 400 dpi

Merge control ~ Lines Overwrite

Data

Include layer information
Include hyperlinks
Create bookmarks
Keep TrueType Fonts
© Embed all referenced fonts
Convert all text to geometry

? Cancel OK
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Layers are now available in the output PDF, and multi-sheet PDF supports different paper size for the

sheets.
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[ NN ) = Floor Plan Sample-
Home  Tools Floor Plan Sample... *

@ B E Q [1] Floor Plan Sample-Model | (1 of 1) k @ @ @
@ Layers X

m =)~ Layer Names o » =
-~
@ & o ) &) Od) OF) Ok
o o s LIRS
@ EBSHEL l Il ll -ll _ 5
@ EBELEV e - '
[; E-B.GLAZ lllll ==1
@ E-BCORE
[@ EBFURR ——] 'l[i_
@ EBMUL -
‘ 1]
@  ECHEAD ‘
~

E-F-CASE 3 S \
N | OF
TER -

Associative Centerlines and Center Marks

AutoCAD 2017 for Mac offers powerful new tools for creating and editing centerlines and center marks.
You can access the Center Mark and Centerline tools from the Draw Menu or on the Dimension panel of
the Drafting tab tool set.

AVA ==

¥ Dimension

‘ 7/
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® Center Mark

¥ Leader // Centerline

TRdla

21



The Centerline tool creates centerline geometry of a specified linetype in association with selected lines

and polylines. The Center Mark tool creates an associative center mark at the center of a selected circle,

arc, or polygonal arc. If you move the associated objects, the centerlines and center marks update
accordingly.

| |Polar: 3.965 < 90.0000°

& =

You can disassociate centerlines and center marks from objects using the CENTERDISASSOCIATE
command. Use the CENTERREASSOCIATE command to reassociate centerlines and center marks with
selected objects.

The following system variables control the appearance of centerlines and center marks:

CENTEREXE — Controls the length of extension line overshoots for centerlines and center marks.

©

ENTERMARKEXE — Determines whether extension lines are created for center marks.

CENTERLAYER — Specifies the layer on which centerlines and center marks are created.

©

(@]

7
&)
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CENTERLTYPE - Specifies the linetype used by centerlines and center marks.

CENTERLTSCAL

© ©
&)

CENTERCROSSSIZE — Determines the size of the central cross for center marks.

©

©

E — Sets the linetype scale used by centerlines and center marks.

CENTERCROSSGAP — Determines the extension line gap between the central cross and the extension
lines of center marks.

©

©

You can modify centerlines and center marks with their grips. A multifunctional grip menu offers more

controls.

E,

I: 0.0f
Stretch

Change Extension Length

i
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You can use the Properties window to view and edit centerline and center mark properties.

Layers

Z 2 Z Z 2Nz
= = 7 » “ —

® " 0 Q |

Unsaved Layer State Unsaved Layer State

© Properties © Properties

Centerline Center Mark
General General
3D Visualization 3D Visualization

Geometry Geometry

0.1x
ss gap 0.05x
Left extension 0.1200
0.1200
0.1200
Bottom extens 0.1200
v/ Show ext...

Use the CENTERRESET command to reset the extension lines of a center mark or centerline object to the
current value of CENTEREXE.

Text Editor Visor
The Text Editor visor now has buttons for formatting text as stacked, superscript, or subscript.

A Standard *  0.2000
4

Text Editor

T Arial m BylLayer ~
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Parametric Menu

The Parametric menu is now a submenu under the Tools menu.

Insert Format Draw Dimension Modify Window Help

Spelling 88: Drawingl.dwg
Draw Order > [ S 5 B
Isolate >

Inquiry >
frame Update Fields

Block Editor
Edit Xref in Place
Open Xref

Load Application...

Geometric Constraints >

AutoConstrain
New UCS >

Constraint Bars B
Named UCS...

: : Dimensional Constraints >
Draftlng_ Settings... Dynamic Dimensions >
Customize >
Express Tools > Delete Constraints

Constraint Settings



Multiple AutoCAD Sessions
If you have a session of AutoCAD running and want to open another, there are a couple ways you can
open another session.

In AutoCAD, right-click on the file tab of the drawing you want to open in another session and click
Move to New Session. This option is available if you have more than one drawing open.

>

New...
Open...
Save
Save As...

Save All
Move to New Session

Close
Close All

Copy Full File Path
Open File Location

You can also right-click on the AutoCAD launch icon and select New AutoCAD Session.

1 MyDwg1.dwg
A Floor Plan Sample.dwg

v/ Drawingl.dwg

New Drawin
New AutoCAD Session

Recent Drawings

Options

Show All Windows
Hide
Quit

You can then arrange the sessions so you can see the drawings side by side.
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Full Screen
AutoCAD 2017 for Mac now supports OSX native Full Screen mode. You can switch to and from Full
Screen using these methods:

e Command+0 or Command+Ctrl+F
e The Full Screen button in the top left of the drawing window

To use the split view with AutoCAD, hold the Full Screen button and drag AutoCAD 2017 for Mac to the
right or left side of the screen.
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License Manager

AutoCAD 2017 for Mac introduces a new License Manager making it easier to change between license
types and save your work when a network license loses connection with the License Manager.

You no longer choose your license type and enter a serial number during the install process. Instead, you
select it when you first launch AutoCAD. You choose between standalone (Enter a Serial Number) and

network (Use a Network License).

AUTODESK

AUTOCAD FOR MAC

Let's Get Started

Enter a Serial Use a Network
Number License

Select your license type or start a trial.

Not Sure? Help me choose p

A button in the About box provides access to the License Manager where you can view information
about the software license and installed Plug-ins, Add-ons, and Extensions. You can also change the type
of license. For example, you can change from a network license or standalone (serial number) to another

license type.

AUTODESK
AUTOCAD
FOR MAC

Product Version

© 2016 Autodesk, Inc. All rights reserved.

All use of this Software is subject to the terms and conditions of
the A desk agr upon of
this Software and/or pack d with the Soft e.

This Product or Service may incorporate or use background Autodesk
technology components. For information about these components, click here:
http://www.autodesk.com/cloud-platform-components.

Trademarks

Tha dne amn onal ~ ~F A

ICAUTODESK

I Manage License |
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License Manager X
Licenses currently in use in this application

Autodesk AutoCAD 2017 for Mac
v Device License : Change license type

Autodesk Plugins, Add-ons and Extensions

There are currently no additional licenses in use in this session. Use an associated feature to

1
1
1
1
1
1
1
1
1
! N . .
1 manage a plugin, add-on or extension license.
1
1
1
1
1
1
1
1

If you are using a network license and you lose your connection to the license server, a message is

displayed indicating that the connection was lost. In the message, you can choose to have AutoCAD save

your drawings and then shut down, or, while time is still available, you can go back to AutoCAD to

manually save your work. The timer to automatically shut down AutoCAD doesn’t start until you dismiss

the message.

Autodesk Account Sign-In
Sign in to your Autodesk account in the upper-right corner of the application window.

Sign In

.
e

s -
= = f

o " 0

Unsaved Layer State

Properties

Once in your account you can:
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e Manage your license and purchase options.
e View Autodesk account details in the AutoCAD Preferences dialog.
e Launch the A360 Desktop App to sync files in the cloud.

2D Graphics

The appearance, selection, and performance of 2D geometry continues to improve in AutoCAD 2017 for
Mac.

In previous releases of AutoCAD, the preview of objects as they were being created, moved, or copied,
could appear jagged.

N, /1IN,

{ ) i ]

In AutoCAD 2017 for Mac, line smoothing is supported during the preview of the just as they will appear

VinNVi

| J

after the operation is completed.

|

In previous releases of AutoCAD, lines with DOT linetypes could be difficult to see even with lineweights
applied. AutoCAD 2017 for Mac supports the lineweight display of DOT linetypes as shown.

oooooooooooooooooooooooooooooo

. rheade
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In addition, linetypes with dash and dot combinations display round dots, unlike previous releases that
represented dots with very short dashes.

||
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|
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Delete Key
A message now displays if you try to delete selected objects using the Delete Key when the PICKFIRST
system variable is set to zero.

Delete Key
Do you want to turn on PICKFIRST?
The PICKFIRST system variable controls whether you can select objects
before you start a This # ing objects and then

pressing the Delete key to erase them.
Aways perform my current cholce

You can avoid displaying the message in the future by selecting the option to always perform your
current choice. You can turn all hidden messages back on in the preferences.

Appication reterences

» £ Working Support File Search Path
» @ Froject Fles Search Path
Customization Files

> L) Text Bditor, Dictionery, ard Fort Mie Names
» ) Prister Susport Fie Path

» [ sunomatic Save Fla Location

» £ cowr book Losetiers

» ) Tmplate Settings

» [ Log Flle Location

> B Yexture Maps Search Puth

» £ Web Ple Search Path

» 2 POF Import Image Location

Help cancel (MO
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Hatch Layer
The HPLAYER system variable has been expanded to allow you to specify a non-existing layer and set it
as default for new hatches and fills.

TEXTEDIT Command

The TEXTEDIT command includes a new Mode option (TEXTEDITMODE system variable) to enable you to
edit multiple text objects without having to restart the command. When the Multiple option is selected,
TEXTEDIT repeats, which enables you to continue selecting text objects for editing. An Undo option
within Multiple mode lets you undo previous editing operations.

Rendering
Rendering is no longer available in AutoCAD 2017 for Mac. The A360 online rendering service is available
using the RENDERONLINE command.

Offline Help

Offline Help is no longer part of the installation. This decreases the size of the install package making it
quicker to download. Offline Help will be available to install separately but is not available for AutoCAD
2017 for Mac.
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